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 Description 

 The class covers the basics of working in a 
SharePoint list for end users. 
 

 Audience 

 Anyone who uses a SharePoint list. 
 

 Prerequisite 

 SharePoint 2010 - Introduction 
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 Introduction to SharePoint Lists 

 Navigating a List 

 Working with List Items 

 Working with List Item Attachments 

 Using Datasheet View 

 Creating Personal Views of a List 

 Integrating Lists with Excel and Outlook 

 Using Alerts 

 E-mailing Links 
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 Defining Lists 
 Built-in Lists 
 Custom Lists 
 List Tasks and Permissions 
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 A list is a collection of 
similar items. 

 Contact info 

 Calendar events 

 Inventory items 

 Lists group items 
together for later 
retrieval or usage. 
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 SharePoint lists store 
data and information, 
not files. 

 List data is organized 
into columns and rows 
like an Access table or 
Excel spreadsheet. 
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 SharePoint has many 
built-in list templates 
and types. 

 The starred types can 
be connected or linked 
to Outlook. 

 Built-in lists can be 
customized as needed. 

Built-In Lists 

Calendars * 

Contacts * 

Announcements 

Tasks * 

Links 

Discussion Boards * 

Issue Tracking 

Surveys 
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 Custom lists can be 
created when there 
isn’t a template that 
meets your needs. 

 Essentially, this is 
creating a list “from 
scratch”. 

Custom Lists 

Grant Data 

Science Data 

Research Data 

Web Usage Report 

References List 

Accomplishments 

Registrations 
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TASKS THAT CAN BE 
 DONE BY ANYONE 

 Viewing item details * 
 Sorting list data 
 Filtering list data 
 Changing the list view 

TASKS THAT MAY REQUIRE 
EXTRA PERMISSIONS 

 Viewing item details * 
 Adding list items 
 Modifying list items 
 Deleting list items 
 Creating views 
 Adding or modifying list 

columns 
 Changing list settings 
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 Using the Breadcrumb Trail 
 Changing the List View 
 Using the Folder Navigation Icon 
 Viewing Additional Pages 
 Using the Manage Views Group 
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 The breadcrumb trail is 
a series of links found 
at the top of a list that 
displays the path of 
where you are. 

 The links can be used 
to navigate up the list 
or site. 
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 The last link of the 
breadcrumb trail 
changes the view of a 
list. 

 A View is a group of 
settings that changes 
how the list items are 
displayed. 
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 The folder navigation 
icon also displays a 
series of links in a 
stepped format that 
can be used to 
navigate up a list or 
site. 

13 



 If a list has more items 
than can be displayed 
on a single page, a 
simple control set will 
be displayed at the 
bottom to navigate the 
pages. 
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 The Manage Views 
group on the List tab 
can be used to change 
the current view AND 
navigate pages of 
items. 
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 Viewing a List Item’s Details 
 Sorting List Items 
 Filtering List Items 
 Selecting Multiple List Items 
 Creating New List Items 
 Editing List Items 
 Using Inline Editing 
 Deleting List Items 
 Restoring List Items 
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 Most lists have more 
details or columns than 
can be displayed in the 
initial view of the list. 

 Open a list item to 
view all of its details or 
properties. 
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 Procedure 

1. Click the field of the list 
item that is a link. 

2. The list item details are 
displayed in a dialog 
box. 

3. Click the Close button 
or the [X] to close the 
dialog box. 
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 List items can be 
sorted by almost any 
column in the list. 

 Some column types are 
“unsortable”. 

 When sorting 
manually, a tiny arrow 
will appear next to a 
sorted column. 
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 The initial sort of a list 
is determined by the 
default view of the list. 

 Views are required to 
do the following: 

 Sorting by more than 
one column. 

 Sorting by a non-visible 
column. 
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 Procedure 

1. Click a column heading 
to sort by that column.  
Click the column 
heading again to 
reverse the sort. 
 OR 

2. Click the column 
heading drop-down 
menu and choose the 
desired sort order. 
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 Filters are used to 
display a selected 
group of list items. 

 The choices in the filter 
list are auto-populated 
by SharePoint. 

 Filters work best on 
columns with repeated 
or similar values. 
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 Procedure 

1. To create a filter, click 
the drop-down menu 
of a column heading. 

2. Select a choice from 
the menu. 

3. The list displays items 
that match the filter. 

4. A filter icon is also 
displayed next to the 
column. 
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 Procedure 

1. To remove a filter from 
a column, click the 
drop-down menu of 
the column heading 
where the filter icon is 
displayed. 

2. Select Clear Filter 
from <columnname>. 
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 Selection checkboxes 
allow a user to select 
multiple list items and 
perform a single 
action. 
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 Use the top selection 
checkbox to select (or 
deselect) all list items. 
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 The selection 
checkboxes can also be 
used to select a single 
item and use an action 
button on the ribbon. 

 This is an alternative to 
using the drop-down 
menu of an item. 
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 Users with the correct 
permissions can create 
new list items. 

 When creating a list 
item, required fields 
will be marked with a 
red asterisk (*). 
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 Procedure 

1. On the Items tab, in 
the New group, click 
the New Item button. 
 OR 
Click +Add new item 
at the bottom. 

2. Enter the list item 
information. 

3. Click either Save 
button when finished. 
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 CAUTION!! 

 If inline editing is 
enabled for a list view 
(more on this topic in a 
moment), the +Add new 
item link will only 
display a green plus sign 
and will NOT launch a 
dialog box. 
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Inline 
editing is 

OFF 

Inline 
editing is 

ON 



 Existing list items can 
be edited or modified 
as necessary. 

 Only users with the 
correct permissions 
can edit list items. 
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 Procedure (Method 1) 

1. Click the drop-down 
menu of the list item 
and choose Edit Item. 

2. Make changes or edits 
as desired. 

3. Click either Save 
button when finished. 
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 Procedure (Method 2) 

1. Select the checkbox of 
the item. 

2. On the Items tab, in 
the Manage group, 
click the Edit Item 
button. 

3. Make changes or edits 
as desired. 

4. Click either Save 
button when finished. 
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 Inline editing allows a 
user to add new list 
items and to edit 
current list items 
without having to 
launch a dialog box. 
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 Inline editing will only 
allow you to work 
with columns that are 
currently visible in the 
view. 

 This option must be 
enabled for a view by 
the list owner. 
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 Procedure 

1. Click the inline edit 
icon next to the list 
item you wish to edit. 

2. Make changes to the 
visible fields. 

3. Click the disk icon next 
to the list item to save 
changes or click the X 
to cancel. 
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 List items can be 
deleted. 

 Deleted items are 
moved to the site 
Recycle Bin. 

 Each site has its own 
Recycle Bin. 
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If you need it, don’t delete it! 



 You will only see the 
items that you 
personally have 
deleted in the site 
Recycle Bin. 

 Must have appropriate 
permissions to delete. 
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If you need it, don’t delete it! 



 Procedure 

1. Click the drop-down 
menu of the list item 
and choose Delete 
Item. 

2. Click OK to confirm. 
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 Deleted items can be 
restored to their 
original locations. 

 Each site has its own 
Recycle Bin. 
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If you need it, don’t delete it! 



 Length of time an item 
stays in the Recycle Bin 
is configured by a 
server administrator. 

 This is a server-wide 
setting, not an individual 
site setting. 
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If you need it, don’t delete it! 



 Procedure 

1. On the Quick Launch 
menu, click the site 
Recycle Bin link. 

2. Select the checkboxes 
of the items you wish 
to restore. 

3. Click Restore 
Selection to restore 
the items. 
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 Attachments and List Items 
 Adding an Attachment to a List Item 
 Opening an Attachment in a List Item 
 Deleting an Attachment from a List Item 
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 Some list types have a 
column type that 
allows you to add an 
attachment to the list 
item. 

 Like an e-mail, you 
need to view the list 
item details to see and 
open the attachment. 
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 The attachment 
column type supports 
multiple attachments. 

 Attachments still 
follow overall 
SharePoint restrictions 
on file types that can 
be uploaded/attached. 
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 Procedure 

1. Open the list item in 
edit mode. 

2. On the Edit tab in the 
Actions group, click 
the Attach File button. 

3. Click Browse to select 
a file to attach. 

4. Click OK when 
finished. 
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 Procedure 

1. Open the list item in 
view or edit mode. 

2. In the Attachments 
field, click the name of 
the attachment to be 
opened. 

3. Click OK to the open 
the document. 
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 Procedure 

1. Open the list item in 
edit mode. 

2. In the Attachments 
field, click Delete next 
to the attachment. 

3. Click OK to confirm the 
delete. 
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 Understanding Datasheet View 
 Switching to Datasheet View 
 Displaying Totals in Datasheet View 
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 Datasheet View 
displays the list in a 
format that looks like 
an Excel spreadsheet 
or an Access table. 
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 Datasheet View allows 
a user to: 

 Navigate a list using the 
keyboard. 

 Use right-click context 
menus. 

 Add, edit, and delete 
items, columns, and 
rows. 

 Display totals. 
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 Procedure 

1. On List tab, in the 
View Format group, 
click the Datasheet 
View button. 

2. To switch back to 
normal view, click the 
Standard View button. 
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 In datasheet view, a 
Total row can be 
displayed for text and 
numeric columns. 

 You may only select 
one total function per 
column. 
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 The functions available 
for number-based 
columns are: 

 Sum 

 Average 

 Count 

 Maximum 

 Minimum 

 Standard Deviation 

 Variance 
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 Totals can be displayed 
for text-based 
columns, however, the 
total is limited to the 
Count function. 
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 Totals cannot be added 
in standard view, 
however, if turned on 
for a view in datasheet 
view, they will be 
displayed at the top of 
the list when viewed in 
standard view. 
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 Procedure 

1. Display the list in 
Datasheet View. 

2. In the Datasheet 
group, click the Show 
Totals button. 

3. The Total row displays 
at the end of the list. 

4. Use the drop-down 
menus in the row to 
select total functions. 
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 About Views 
 Types of Views 
 Creating a Personal View of a List 
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 A View is a collection 
of settings that 
determines how the 
items in a list will be 
displayed. 

 Views are found at the 
end of the breadcrumb 
trail and in the Manage 
Views group. 
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 Public View 

 Can be created by 
anyone with sufficient 
rights to create views. 
▪ Usually a list owner and/or 

a site owner. 

 A public view is available 
to all users of the list. 
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 Personal View 

 Anyone can create a 
personal view. 

 A personal view is only 
available to the person 
who created the view. 
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 Procedure 

1. On the List tab, in the 
Manage Views group, 
click the Create View 
button. 
 

 OR 
 

Click the view link at 
the end of the 
breadcrumb trail and 
select Create View. 
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 Procedure (continued) 

2. Select Standard View 
to create a new view, 
or select an existing 
view from the list. 

3. Give the view a name. 

4. Select the desired 
options for the view. 

5. Click OK when 
finished. 
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 Lists and Office Applications 
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 SharePoint lists can 
share data and 
integrate with several 
Office applications. 

 Access 

 Excel 

 Outlook 

 Project 

 SharePoint Workspace 

 Visio 
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 In this course, we will 
look at two of the most 
common procedures. 

 Exporting SharePoint list 
data to Excel 

 Connecting a SharePoint 
list to Outlook 
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 Using Excel with Lists 
 Preparing to Export to Excel 
 Exporting a List to Excel 
 Refreshing the List Data in Excel 

 Manually 

 Automatically 

 The Consequences of Refreshing Data 
 Unlinking an Excel Spreadsheet 
 Importing from Excel 
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 The data in a list can 
be exported to Excel 
for a variety of 
purposes. 

 More formatting and 
printing options. 

 Creating a chart. 

 Analyzing the data with 
a PivotTable. 
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 Once exported, a “one-
way connection” is 
maintained between 
Excel and SharePoint 

 Changes to the list data 
in SharePoint can be 
pulled down into Excel. 

 Changes made in Excel 
CANNOT be pushed up 
to SharePoint. 
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 CAUTION!! 

 When exporting list data 
to Excel, SharePoint will 
only export the currently 
visible columns. 

 It may be necessary to 
change the list view 
before performing the 
export. 
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 Procedure 

1. On the List tab, in the 
Connect & Export 
group, click the Export 
to Excel button. 

2. In the File Download 
dialog box, choose 
Open. 

3. Excel opens with the 
list data displayed and 
formatted as a table. 
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 As part of the export, 
two columns labeled 
Item Type and Path 
are also displayed at 
the far right of the 
table data. 

 These columns can be 
safely deleted. 
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 Changes made to the 
list in SharePoint are 
not automatically 
pushed to Excel. 

 You must either: 

 Manually refresh the 
data. 

 Configure the file to 
refresh automatically 
when opened. 
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 Procedure 

1. In Excel, click the table 
data to display the 
Table Tools. 

2. On the Design tab, in 
the External Table 
Data group, click the 
Refresh button. 
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 Procedure 

1. Click the bottom of the 
Refresh button and 
choose Connection 
Properties. 

2. In the Connection 
Properties dialog box, 
in the Refresh control 
section, select the 
desired options. 

3. Click OK. 
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What will happen to ITEMS  
 when you perform a refresh in Excel… 

If items have been added in SharePoint,  
 they will be added to Excel. 

If items have been deleted in SharePoint,  
 they will be deleted from Excel. 

If items have been changed in SharePoint,  
 they will be changed in Excel. 

If items have been changed in Excel,  
 the changes in Excel will be lost. 
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What will happen to ROWS  
 when you perform a refresh in Excel… 

If rows have been added INSIDE the Excel table, 
 they will be deleted. 

If rows have been added OUTSIDE the Excel table, 
 they will remain. 

If rows have been deleted from the Excel table, 
 they will be restored. 
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What will happen to COLUMNS 
 when you perform a refresh in Excel… 

If columns have been added to the Excel table, 
 they will remain. 

If columns have been deleted from the Excel table, 
 they will not be restored. 
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 Unlinking breaks the 
connection between 
the Excel data table 
and the SharePoint list. 

 The existing data will 
remain in Excel. 
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 Breaking the link 
between an Excel data 
table and a SharePoint 
list is permanent. 

 There is no way to 
restore the connection. 
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 Procedure 

1. In Excel, click the table 
data to display the 
Table Tools. 

2. On the Design tab, in 
the External Table 
Data group, click the 
Unlink button. 

3. Click OK to confirm 
and continue. 
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 If we can export list 
data from SharePoint 
to Excel, is it possible 
to go the other way 
and take an Excel 
spreadsheet and 
import its information 
into a SharePoint list? 
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 It is possible to import 
an Excel spreadsheet 
to a SharePoint list 
however, this can only 
be done when 
creating a new list. 

 You cannot import Excel 
data into an existing 
SharePoint list. 
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 Since only site owners 
and administrators can 
create new SharePoint 
lists, we will not be 
covering the import 
process in this class. 
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 Using Outlook with Lists 
 Connecting a List to Outlook 
 Managing Update Conflicts 
 Deleting a Link to SharePoint 
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 Several list types in 
SharePoint can be 
connected to Outlook. 

 Contacts 

 Tasks 

 Calendars 

 Discussion Boards 
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 The connection is a 
“two-way” connection 
between Outlook and 
SharePoint. 

 Data can be updated in 
either SharePoint or 
Outlook and it will 
eventually “refresh” on 
both sides. 
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 Procedure 

1. On the List tab, in the 
Connect & Export 
group, click the 
Connect to Outlook 
button. 

2. Confirm and Allow the 
connection. 

3. The list appears in 
Outlook. 
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 Question: 

 What if two people have 
the same item open at 
the same time in both 
SharePoint and 
Outlook?  Whose 
changes will win? 
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 Answer: 

 Whoever saves first 
wins. 

 The losing party will 
either see an error, or 
the changes will simply 
not be saved. 
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 Deleting a link breaks 
the connection 
between Outlook and 
the SharePoint list. 

 The existing data will 
NOT be displayed in 
Outlook. 
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 Procedure 

1. Display the folder list 
in Outlook. 

2. Right-click on the 
name of the 
SharePoint list. 

3. Choose Delete Folder 
or Delete Calendar. 

4. Click Yes to confirm. 
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 NOTE! 

 The text of the confirmation dialog box that Outlook 
displays when deleting a link is a bit unclear. 

 This procedure is only deleting the LINK, nothing on 
SharePoint is being changed or deleted. 
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 About Alerts 
 Best Practices for Alerts 
 Creating an Alert for a List Item 
 Creating an Alert for a List 
 The Two Alert Me Buttons 
 Managing Alerts in SharePoint 
 Managing Alerts in Outlook 2007 
 Managing Alerts in Outlook 2010 
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 Alerts can notify you 
automatically via  
e-mail based on the 
conditions you set. 

 When a list item is 
modified 

 When a list item is 
deleted 

 When new items are 
added to a list 
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Use SharePoint 
to create alerts 

Use Outlook to 
manage alerts 
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 Alerts can be created 
for single list items. 

 The alert conditions 
only apply to the item 
selected. 

 Use one of the 
following two methods 
to create an alert. 
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 Procedure (Method 1) 

1. Click the drop-down 
menu of the list item 
and choose Alert Me. 

2. Select the desired alert 
options and click OK. 
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 Procedure (Method 2) 

1. Select the checkbox of 
the list item. 

2. On the Items tab in the 
Share & Track group, 
click the Alert Me 
button and choose Set 
alert on this item. 

3. Select the desired alert 
options and click OK. 
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 Alerts can be created 
for the entire list. 

 The alert conditions 
apply to the entire list. 
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 Procedure 

1. On the List tab, in the 
Share & Track group, 
click the Alert Me 
button and choose Set 
alert on this list. 

2. Select the desired alert 
options and click OK. 
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 CAUTION!! 

 There are two Alert Me 
buttons on the ribbon. 

 On both the Items tab 
and the List tab. 

 They look the same but 
they do different things.  

 Make sure you select the 
correct button when 
creating alerts. 
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 Each SharePoint site 
maintains its own list 
of alerts for a user. 

 SharePoint lacks a 
central interface for all 
of a user’s alerts across 
all sites. 
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 Procedure (Method 1) 

1. Click either Alert Me 
button and choose 
Manage My Alerts. 

▪ To create new alerts, 
click Add Alert and 
follow the prompts 

▪ To delete alerts, select 
the checkboxes next to 
the alerts and click 
Delete Selected Alerts.  
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 Procedure (Method 2) 

1. Select the username 
menu in the upper 
right-hand corner and 
choose My Settings. 

2. On the User 
Information screen, 
click My Alerts. 

3. Use Add or Delete as 
desired. 
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 Outlook can be used to 
manage your 
SharePoint alerts. 

 Outlook will display 
ALL alerts across ALL 
SharePoint sites. 
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 Procedure (2007) 

1. In the Inbox, select the 
Tools menu and 
choose Rules and 
Alerts. 

2. In the Rules and Alerts 
dialog box, select the 
Manage Alerts tab. 

3. Click OK when 
finished. 
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 Procedure (2010) 

1. In the Inbox, on the 
Home tab, in the Move 
group, click the Rules 
button and choose 
Manage Rules & 
Alerts. 

2. In the Rules and Alerts 
dialog box, select the 
Manage Alerts tab. 
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 Using E-mail to Share Links 
 E-mailing a Link to a List 
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 Instead of giving a user 
“detailed instructions” 
on how to find a list, 
send a link in an e-mail. 

 E-mailed links are 
subject to permissions. 

 The link will not work if 
the receiving user does 
not have permission to 
access the list. 
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 Procedure 

1. On the List tab, in the 
Share & Track group, 
click the E-mail a Link 
button. 

2. An e-mail will open 
with a link to the list. 

3. Complete the e-mail 
and Send it. 
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 Microsoft Office Online 
 Recommended Books 
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 office.microsoft.com 

1. Select the Support 
menu and choose All 
Support. 

2. Make sure the Version 
drop-down displays 
2010. 

3. Use right arrow to 
scroll and select the 
SharePoint Server 
icon. 
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 SharePoint 2010 Plain & Simple 
 J. Lightfoot and C. Beckett 

 Microsoft Press 

 The SharePoint Shepherd’s 
Guide for End Users 
 Robert Bogue 

 SharePoint 2010 User’s Guide 
 S. Bates and T. Smith 

 Apress 

 SharePoint Foundation 2010 
 O. Londer and P. Conventry 

 Microsoft Press 
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